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Frontispiece. Composite digital images, magnetic susceptibility (MS), and CaCO3 through the Paleocene–Eocene
transition at the shallow to deep transect. The MS graphs represent both point magnetic susceptibility (PMS) data
measured on the split core and loop sensor (MSL) data measured on the whole core. For correlation of these two methods,
1-cm resolution PMS data were linearly interpolated at 2.5-cm resolution, after which a linear expansion formula was
calculated and PMS values were normalized to MSL values: MSL = 2.0683 × PMS + 7.8257 (r2 = 0.9885). For Site 1263, MS
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data from Hole 1263C are spliced with data from Hole 1263D at 335.88 meters composite depth (mcd). Sample depths
for Hole 1263D were normalized to Hole 1263C mcd using a linear expansion based on PMS correlation through the P/E
transition: Hole 1263C mcd = Hole 1263D mcd × 1.383 – 128.45. For Site 1262, sample depths of CaCO3 data from Hole
1262A (Core 208-1262A-13H) were normalized to Hole 1262B mcd using a linear expansion based on PMS correlation
through the lower part of the P/E transition: Hole 1262B mcd = Hole 1262A mcd × 1.1343 – 18.785 (r2 = 0.996; only for
data below 139.95 mcd). At Site 1266, CaCO3 data from Hole 1266B (Section 208-1266B-6H-7) give way to Hole 1266C
values at 306.56 mcd. T = top (last occurrence), B = bottom (first occurrence).
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CD-ROM volume citation:
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Ocean Drilling Program, Texas A&M University, College Station TX 77845-9547, USA.

CD-ROM chapter citation:
Shipboard Scientific Party, 2004. Site 1262. In Zachos, J.C., Kroon, D., Blum, P., et al., Proc. ODP, Init. 
Repts., 208, 1–93 [CD-ROM]. Available from: Ocean Drilling Program, Texas A&M University, College 
Station TX 77845-9547, USA.
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Copies of this publication may be obtained from Publications Distribution Center, Ocean Drilling 
Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-9547, USA. See the 
ODP publication list at www-odp.tamu.edu/publications or contact ODP for prices and ordering 
information. Orders for copies require advance payment.
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Book: 0884-5883; CD-ROM: 1096-2522; World Wide Web: 1096-2158
Library of Congress 87-642-462
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PUBLISHER’S NOTES
This volume also appears on the World Wide Web. Any scientific corrections, revisions, or additions will 
be noted in the chapter (see “Chapter Notes”) at www-odp.tamu.edu/publications.

This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 
work performed under the international Ocean Drilling Program, which is managed by Joint 
Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 
the program was provided by the following agencies at the time of this cruise:

Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and 
Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Ireland, Italy, 

The Netherlands, Norway, Portugal, Spain, Sweden, and Switzerland)

Institut National des Sciences de l’Univers–Centre National de la Recherche Scientifique (INSU-CNRS) (France)

Marine High-Technology Bureau of the State Science and Technology Commission of the People’s Republic of 
China

National Science Foundation (United States)

Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

http://www-odp.tamu.edu/publications
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Any opinions, findings, and conclusions or recommendations expressed in this publication are those of 
the author(s) and do not necessarily reflect the views of the National Science Foundation, the 
participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M 
Research Foundation.

Abbreviations for names of organizations and publications in ODP reference lists follow the style given 
in Chemical Abstracts Service Source Index (published by American Chemical Society).

The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is 
accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, 
please contact the ODP Data Librarian, Ocean Drilling Program, Texas A&M University, College Station 
TX 77845-9547, USA. E-mail: database@odpemail.tamu.edu.

Some close-up core photographs have been tonally enhanced to better illustrate particular features of 
interest.
Supplemental data on the volume CD-ROM were provided by the authors and may not conform to 
ODP publication standards.

A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available on the 
volume CD-ROM in PDF format. These maps were produced using Generic Mapping Tools (GMT) of 
Paul Wessel and Walter H.F. Smith (gmt.soest.hawaii.edu).

Cover photograph of the JOIDES Resolution rig at sunrise was taken by Co-Chief Scientist Jim Zachos.

http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
http://gmt.soest.hawaii.edu
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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 
address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment, the evolution of oceanic crust, and the fluctuations of climate. In addition, 
study of the Earth’s deep biosphere is an emergent research objective.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship 
JOIDES Resolution. This state-of-the-art research vessel contains eight levels of laboratories and other scientific 
facilities required for carrying out the program’s objectives.

The management of ODP involves a partnership of scientists and governments. International oversight and 
coordination are provided by the ODP Council, which is made up of representatives from the member 
countries. Overall scientific and management guidance is provided by representatives from the Joint 
Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 18 U.S. oceanographic institutions, serves 
as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, plans, and 
recommendations of the JOIDES committees through major subcontracts to Texas A&M University (TAMU) for 

science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical 
and geophysical well-logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling 
Program. We look forward to many exciting discoveries and continued international collaboration as we further 
our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
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following information applies.

PC COMPUTERS
By default, double-clicking on a filename with a .TXT extension will launch the Notepad application. 
You can configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 
menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98, 2000, 
ME, and XP systems: View > Folder Options > File Types.

MACINTOSH COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 
on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.
UNIX COMPUTERS
You can open files with .TXT extensions in any text editor or spreadsheet program, but not directly 
from PDF files.

Chapter 1 Chapter 5 Chapter 8

Chapter 3 Chapter 6 Smear slide tables

Chapter 4 Chapter 7
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Chapter 1, Leg 208 Summary
Table T3. Calcareous nannofossil and planktonic foraminiferal datum levels in the Eocene–Oligocene 
transition interval.

Chapter 3, Site 1262
Table T3. Splice tie points, Site 1262.
Table T15. Age-depth control points, Site 1262.
Table T16. Age model, linear sedimentation rates, and mass accumulation rates, Site 1262.

Chapter 4, Site 1263
Table T3. Splice tie points, Site 1263.
Table T15. Age-depth control points, Site 1263.
Table T16. Age model, linear sedimentation rates, and mass accumulation rates, Site 1263.

Chapter 5, Site 1264
Table T3. Splice tie points, Site 1264.
Table T15. Age-depth control points, Site 1264.
Table T16. Age model, linear sedimentation rates, and mass accumulation rates, Site 1264.

Chapter 6, Site 1265
Table T3. Splice tie points, Site 1265.
Table T17. Age-depth control points, Site 1265.
Table T18. Age model, linear sedimentation rates, and mass accumulation rates, Site 1265.
Chapter 7, Site 1266
Table T3. Splice tie points, Site 1266.
Table T13. Age-depth control points, Site 1266.
Table T14. Age model, linear sedimentation rates, and mass accumulation rates, Site 1266.

Chapter 8, Site 1267
Table T3. Splice tie points, Site 1267.
Table T13. Age-depth control points, Site 1267.
Table T14. Age model, linear sedimentation rates, and mass accumulation rates, Site 1267.
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Smear Slide Data Tables
Hole 1262A smear slide table.
Hole 1262B smear slide table.
Hole 1262C smear slide table.
Hole 1263A smear slide table.
Hole 1263B smear slide table.
Hole 1263C smear slide table.
Hole 1263D smear slide table.
Hole 1264A smear slide table.
Hole 1264B smear slide table.
Hole 1264C smear slide table.

Hole 1265A smear slide table.
Hole 1265B smear slide table.
Hole 1265C smear slide table.
Hole 1266A smear slide table.
Hole 1266B smear slide table.
Hole 1266C smear slide table.
Hole 1267A smear slide table.
Hole 1267B smear slide table.
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CD-ROM CONTENTS: SUPPLEMENTARY MATERIAL
The Initial Reports CD-ROM contains supplementary material data files presented as Excel 97/98 
spreadsheets. The files present calcareous nannofossil and planktonic and benthic foraminifer 
paleontological data. Supplementary material files are located in the SUPP_MAT directory.

PALEONTL

1262_PAL
BENTHIC
03_T09.XLS

CALC_NAN
03_T05.XLS
03_T07.XLS

PLANKTIC
03_T06.XLS
03_T08.XLS

1263_PAL
BENTHIC
04_T09.XLS

CALC_NAN
04_T05.XLS
04_T06.XLS

PLANKTIC
04_T07.XLS
04_T08.XLS

1264_PAL

1265_PAL
BENTHIC
06_T09.XLS

CALC_NAN
06_T05.XLS
06_T06.XLS

PLANKTIC
06_T07.XLS
06_T08.XLS

1266_PAL
BENTHIC
07_T09.XLS

CALC_NAN
07_T05.XLS
07_T06.XLS

PLANKTIC
07_T07.XLS
07_T08.XLS

1267_PAL
BENTHIC
BENTHIC
05_T09.XLS

CALC_NAN
05_T05.XLS

05_T07.XLS
PLANKTIC
05_T06.XLS
05_T08.XLS

08_T09.XLS
CALC_NAN
08_T05.XLS
08_T06.XLS

PLANKTIC
08_T07.XLS
08_T08.XLS

README.TXT
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CD-ROM CONTENTS: DRILLING LOCATION MAPS

Two site maps showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF.

ODP Leg 208 Site Map A

ODP Leg 208 Site Map B

ODP Map (Legs 100–208)

DSDP Map (Legs 1–96)
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RELATED LEG DATA

DOWNHOLE LOGGING AND CORE DATA 

A CD-ROM containing processed logging data and a subset of core data is included with the printed 
version of this volume. However, a more complete set of the logging data collected by ODP Logging 
Services is available online at www.ldeo.columbia.edu/BRG/ODP/DATABASE/DATA/search.html. If 
you have problems downloading the data, wish to receive additional logging data, or have questions 

regarding the data, please contact: Data Services Manager, ODP Logging Services, Borehole Research 
Group, Lamont-Doherty Earth Observatory of Columbia University, PO Box 1000, 61 Route 9W, 
Palisades NY 10964, USA; Tel: (845) 365-8343; Fax: (845) 365-3182; E-mail: 
logdb@ldeo.columbia.edu.

The majority of the core data on the CD are available on the Web at www-odp.tamu.edu/database. 
If you cannot access the ODP database or need additional data, please contact: ODP Data Librarian, 
Ocean Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-
9547, USA; Tel: (979) 845-8495; Fax: (979) 458-1617; E-mail: database@odpemail.tamu.edu.

http://www.ldeo.columbia.edu/BRG/ODP/DATABASE/DATA/search.html
mailto:logdb@ldeo.columbia.edu
http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
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COMPILED ELECTRONIC INDEX
The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program included on the volume 
CD-ROM contains individual indexes of Volumes 101–178, 180, 181, 183, and 186. The indexes are 
contained in the directory titled ODPINDEX and are named ###NDX.PDF (### = the leg number). 
These indexes can be searched individually or collectively. For information on using the Acrobat search 
function, see “Searching a PDF Document” in README.PDF.
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CD-ROM DIRECTORY STRUCTURE 

ACROREAD
(Acrobat Reader installation 
software and instructions for 
different platforms)

208IR.PDF
(Preliminary pages and table of contents)

README.TXT

IR208_01.PDF (Leg 208 Summary)VOLUME
(Leg 208 Initial Reports volume)

README.PDF
(Information about the volume CD-ROM)

README.TXT
(ASCII version of information about the volume CD-ROM)

MAPS
(Drilling location maps)

ODPMAP.PDF (ODP map, Legs 100 through 208)

CHAPTERS
(Volume chapters)

208_MAPA.PDF (Leg 208 site map)

IR208_02.PDF (Explanatory Notes)

IR208_03.PDF (Site 1262)

IR208_04.PDF (Site 1263)

IR208_05.PDF (Site 1264)

IR208_06.PDF (Site 1265)

DSDPMAP.PDF (DSDP map, Legs 1 through 96)

TABLES
(ASCII versions of age control point, 
age model, mass accumulation rate, 
splice tie point, and smear slide data 
tables)

IR208_01 (Leg 208 Summary file)

IR208_03 (Site 1262 files)

IR208_04 (Site 1263 files)

S_SLIDES (Sites 1262 through 1267)

README.TXT

(Continued on next page)

OVERSIZE
(Large-format tables)

IR208_04 (Site 1263 files)

IR208_05 (Site 1264 files)

COR_1262.PDF (Site 1262)CORES
(Visual core descriptions, smear
slide data tables, and digital core 
images)

COR_1263.PDF (Site 1263)

COR_1264.PDF (Site 1264)

IMAGES (PDF files of core images)

IR208_07.PDF (Site 1266)

IR208_08.PDF (Site 1267)

COR_1265.PDF (Site 1265)

COR_1266.PDF (Site 1266)

COR_1267.PDF (Site 1267)

IR208_06 (Site 1265 files)

IR208_07 (Site 1266 files)

IR208_08 (Site 1267 files)

IR208_06 (Site 1265 files)

IR208_05 (Site 1264 files)

MAC

UNIX

WINDOWS

208_MAPB.PDF (Leg 208 site map, continued)

IR208_07 (Site 1266 files)

IR208_08 (Site 1267 files)
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CD-ROM DIRECTORY STRUCTURE (CONTINUED)

ODPINDEX
(Compiled Electronic Index of the
Proceedings of the Ocean Drilling
Program)

101NDX.PDF through 178NDX.PDF,
180NDX.PDF, 181NDX.PDF, 183NDX.PDF, 
and 186NDX.PDF
(Index files)

NDX.PDX
(Acrobat file used to enable Acrobat Search of the
Compiled Electronic Index)

SUPP_MAT
(Supplementary Material)

PALEONTL
(Excel 97/98 spreadsheets of 
calcareous nannofossil and benthic 
and planktonic foraminifer 
paleontological data)

1262_PAL (Site 1262 files)

1263_PAL (Site 1263 files)

VOLUME
(Continued)

INDEX.PDX
(Acrobat file used to enable Acrobat Search of the 
Leg 208 Initial Reports) 

1264_PAL (Site 1264 files)

1265_PAL (Site 1265 files)

1266_PAL (Site 1266 files)

1267_PAL (Site 1267 files)

README.TX
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